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Synopsis

AD-HOC Query is an intra organizational application, which is
developed to generate the query as per the user requirements. The Fnd
User can make their work c€asy, as the product can generate the query
depending on his requirements, This involves addijtional features such as
Query Debugger, Data Transmission Services (DTS), Backups &

Recovery and providing Access Rights.

Query Wizard is a step by step wizard which guides the user to
build the query. The user is allowed to choose the type of database with
the necessary login id and password. Depending on the login the tables of
the database are made available to the user for making the query. The
wizard is enriched with proper clauses, sub-queries and joins. Finally, the

query formed can be stored for future use.

Query Debugger is a user-friendly interface that allows a user 10
create a SQL statement with user having less knowledge about the syntax
of the SQL command or statement. This interface provides property fist
boxes like Visual Basic where the needed one’s are selected. The created

SQL statement is compiled and can be saved for fiture use.

DTS allows migration of data between databases, text files and
spreadsheets. The tables from Oracle can be imported to Oracle, SQI.
Server and vice versa, Automatic conversion of datatypes is done during
migration of tables between two different databases, Similarly the tables in
the database can be exported to text files. The data exported 1o the text
files can be also imported to the database. The text files that are imported
to the databases have a predefined format. During data migration the
datatypes used by databases are also specified. The data can be migrated

between the database and excel sheets.



AD-HOC Query includes another vital function i.e. taking backups.
Here the user can select the tables that are needed for firture use and can
send the information from the table to files. These files can be alo
recovered whenever needed by specifying the file path. Administrator can
grant rights to other users. The access rights include select, insert, update

and delete. These rights can be also revoked.

The product also facilitates the Help Desk System, which guides
the user for using this product. The Help System is built using HTML.
pages with appropriate links and these are viewed using the Form Browser,
The application uses Visual Basic as its front end, Oracle and SQL Server

as its backend.
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L.0. Introduction

1.1. About the Organization:

Allsec Technosoft Ltd. s part of the Allsec group and is a
global IT solutions provider offering professiona services in Application
Software Development, Business Solutions Consultancy, Enterprise-to-Web

Solutions,

Allsec Technosoft has been in existence for the past 6 vears
offering a combination of software products and bespoke software applications
across different verticaj industries, The uniqueness about our offerings is the
combination of domain experts in various fields, backed up by qualified technica
personnel in different platforms. We firmly believe in offering end to end
solutions for oyr customers. Adding value functionally and technical Iy to our end
customers is our ultimate objective. We are a process driven company and follow
CMM Level 3 standards. Great emphasis is placed on timely delivery of quaj ity

software applications at cost effective rates,

1.2. About the Project:

AD-HOC Query is an intra organizational application, which is
developed to generate the query as per the user requirements. The End User
can make their work casy, as the product can generate the query depending on
his requirements. This involves additionai features such as Query Debugger.
Data Transmission Services (DTS), Backups & Recovery and providing

Access Rights,

sub-queries and joins. Finally, the query formed can be stored for future uge,
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Query Debugger is a user-friendly interface that allows a user to create
a SQL statement with user having less knowledge about the Syntax of the SQL
command or statement. The created SQL statement is compiled ang can be

saved for future yse.

DTS allows migration of data between databases, text files and
Spreadsheets. The tables from Oracle can be imported to Oracle, SQL Server
and vice versa, Similarly the tables in the database can pe exported to text
files. The data exported to the text files can he also imported to the database.
The text files that are imported to the databases have a predefined format.
During data migration the datatypes used by databases are also specified. The

data can be migrated between the database and exce] sheets.

AD-HOC Query includes another vital function i.e. taking backups,
Here the user can select the tables that are needed tor future use and can send
the information from the table to files. These fileg can be also recovered
whenever needed by specifying the file path. Administrator can grant rights to
other users. The access rights include select, insert, update and delete, “hese

rights can be also revoked.

backend.
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2. Background

2.1. System Requirements

2.1.1. Software Profile:

VISUAL BASIC 6.0:

Visual Basic is g powerful Programming system for developing
sophisticated graphical applications for Microsoft windows environment.
Its productivity has been enhanced by addition ofa complete set of tools to

simplify rapid application development.

Visual Basic 6.0 introduces us to the new world of active
technology, a unique way to harness the Internet. Visual Basic offers many
silent features 10 aid in the development of full-featured applications

including,

¢ Data access functionality allows creation of front-end applications the

can work on most of the popular databases systems.

* Active TM technology allows usage of the functionality provided by
other applications, such as Microsoft Word, Microsoft Excel, and other

windows applications and their possible development on the web,

* Applications developed using Visual Basic provides a true EXE file

that uses a runtime Dynamic-Link Library (DLL) which can be freely
distributed,

* Calling powerfy] AP] functions available in Visual Basic optimizes

application performance.
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ACCESSING DATABASES:

Visual Basic provides a set of tools created and use structured
database systems to manage application data. These tools are Microsoft
Jet Database Engine, the Data Control and the Data Access Objects (DAOQ)
programming interface. Visual Basic provides Jet Database, version 3.5
for 32-bit programming. The Data Control and Data Access Objects are

the interfaces used to connect to the Jet Database Engine.

ADO (ActiveX Data Objects):

ActiveX Data Objects also called as universal data object .VB 6.0
Supports wide range of ADQ. Since Objects are ActiveX based, they work
across different platforms and programming languages unlike data control
works strictly in the VB environment. The most importance of ADO is its
capability tom access many kinds of data Not limited to just relational and

non-relational database

MS SQL Server:

Client/Server Architecture:

Microsoft SQL Server is designed to work effectively in a number of
environments;

* Asatwo-tier or multitier client/server database system

* Asadesktop database system

Client/Server Database Systems:

* Client/server systems are constructed so that the database can reside on a
central computer, known as a server, and are shared among several users.

Users access the server through a client or server application,
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In a two-tier client/server System, users run an application on their local
computer, known as a client that connects over a network to the server running
SQL Server. The client application runs both business logic and the code 1o

display output to the user, and is aiso known as a thick client,

In a multitier client/server System, the client application logic is run in two

locations:

results to the user.,

The business logic is located in server applications running on a server. Thin
clients request functions from the Server application, which is itself a
muitithreaded application capable of working with many concurrent users, The
Server application is the one that Opens connections to the database server and
can be running on the same server as the database, or it can connect across the

network to a separate server Operating as a database server,

This is a typical scenario for an Internet application. For example, a serve-

server application uses a pool of connections to communicate with a copy of
SQL Server., SQL Server can be instalied on the same computer as IS, or it

can be installed on g Separate server in the network.

Having data stored and managed in a central location offers several advantages;

Each data item is stored in a central location where all users can work with it.
Separate copies of the item are not stored on each client, which eliminates
problems with users having to ensure they are 3l working with the same

information.



Adhoc Query % '

* Business and security rules can be defined one time on the server and enforced

equally among all users,

¢ This can be done in a database through the use of constraints, stored

procedures, and triggers. It can also be done in a server application.

* A relational database server optimizes network traffic by returning only the

data an application needs.

ORACLE:

Oracle is an Object Relational Database Management System (ORDBMS). 1t
offers capabilities of both relational and object-oriented database systems. In
general, objects can be defined as reusable software codes, which are location
independent and perform a specific task on any application environment with little

or no change to the code.

Oracle products are based on Client/Server Technology. This concept involves
segregating the processing of an application between two systems. The Client or
front end database application also interacts with the database by requesting and

receiving information from the database server.

Oracle uses the Internet File System, which is a Java based application, which
enables the database to become an Internet development platform. The data stored
in the database can be used for building HTML web pages. Oracle also provides
support for building Java application by offering a new version of Jdeveloper.
Corba 2.0 complaint Object Request Broker (ORB) that provides users with
ability to call in and out of the object sever using Corba’s [TOP, which is alsc

integrated with Oracle.

10
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2.1.2. Hardware Requirements:

Minimum Requirement:
* 128 MB RAM
® Processor P-I]

* 20GB HDD
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3.0. System Description

3.1. System Study and Analysis

3.1.1. Purpose:

The purpose of this document is to understand the modules in ADHOC
Query. The modules included in the product have been listed along with a

detailed description of functions involved in each module.

3.1.2. Scope:

The scope of this project is to provide a user-friendly interface for
creating query, migrating data, to provide rights, writing SQL statement and

overall to make the work easy for the user.

3.2. Modules:

Modules Sub-modules
Query Generator » Query Wizard .
»  Query Debugger
DTS » Databases
#» Text Formats
»> Spreadsheets
Helpdesk » Query Help
» DTS Help
Security » Backups -
»  Access Rights
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3.2.1. Definitions, Acronyms and Abbreviations:

DTS

Data Transformation Services

Admin

Administrator

3.2.2. References:

¥" VB 6.0 — Black Book & www.microsoft.com

v Software Engineering — A practitioner’s Approach

By Roger Pressman

v Oracle 91, by Nancy Greenberg
v" SQL Server Books - Online Help

v" SQL Server books, by Fernando G. Guerrero

3.2.3. Overview:

a Query Wizard

Query Wizard is a step by step wizard which guides the user to build
the query. The user is allowed to choose the type of database with the
necessary login id and password. Depending on the login the tabies of the
database are made available to the user for making the query. The wizard is

enriched with proper clauses, sub-queries and joins. Finally. the query formed

can be stored for future use,

o Query Debugger
Query Debugger is a user-friendly interface that allows a user to create
a SQL statement with user having less knowledge about the syntax ot the SQL
command or statement. This interface provides property list boxes like Visual

Basic where the needed one’s are selected. The created SQL statement is

compiled and can be saved for future use.

14
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a DTS

DTS allows migration of data between databases, text files and
spreadsheets. The tables from Oracle can be imported to Oracle, SQL Server
and vice versa. Automatic conversion of datatypes is done during migration of
tables between two different databases. Similarly the tables in the database can
be exported to text files. The data exported to the text files can be also
imported to the database. The text files that are imported to the databases have
a predefined format. During data migration the datatypes used by databases
are also specified. The data can be migrated between the database and excel

sheets.
o Backups and Recovery

AD-HOC Query includes another vital function i.e. taking backups.
Here the user can select the tables that are needed for future use and can send
the information from the table to files. These files can be also recovered

whenever needed by specifying the file path.
a Access Rights

Administrator can grant rights to other users. The access rights inciude

select, insert, update and delete. These rights can be also revoked.
a Help Desk

The product also facilitates the Help Desk System. which guides the
user for using this product. The Help System is built using HTML pages with

appropriate links and these are viewed using the Form Browser.
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3.2.4. General Description:

Products Perspective

% Dynamic Query Generation.
“ Automatic datatype conversion during data migration.
% User-friendly interface for writing SQL statements.

“* Help provides a comprehensive report for using the product.

Products Functions

o Query Wizard

* Oracle
= MSSQL
o Query Debugger
*  QOracle
* MSSQL
a DTS

= Database
v" Oracle to Oracle
¥ Oracle to SQL
v" SQL to SQL
v" SQL to Oracle

* Tile
v" Oracle to File
v" File to Oracle
v" SQL to File
v File to SQL

= Spreadsheets
v" Oracle to Excel
v Excel to Oracle
v SQL to Excel
v Excel to SQL
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a Access Rights

= Oracle Access Rights

=  SQL Server Access Rights
o Backups and Recovery

=  Qracle Backups and Recovery

»  SQL Server Backups and Recovery
a Help Desk

= Query Help

= DTS Help

User Characteristics

The user should be able to operate a computer under the Windows

operating system.
General Constraints

Some of the constraints when using the application can be listed below
v The Application can be used with minimum 96 MB RAM.

v The Application uses SQL server and Oracle as database.



Adhoc Query E ;

3.2.5. Overview of Modules:

Module U00C_——— =  3.2.5.1.Data Transformation Services

Module Functions

Functions List

The following are the functions provided by this module

» Database
» File
> Spreadsheet

Database

Functional Requirements

This function is used to collect Table information, Login information and etc.

This is used for migrating data between the databases.

Description

. The function is described as a step by step procedure given below: -

I. The user selects the type of option for data migration. The following options

are: -

a) Oracle to Oracle

b} Oracle to SQL Server

c) SQL Server to SQL Server
d) SQL Server to Oracle

18
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Depending upon the option selected the Login information is collected

&

from the user. The tables are displayed in a tree structure. Then. the user
selects the tables, columns that are needed to be migrated.
3. The functions like avg( ), max( ) etc. for the columns are also provided by
the user. The next step results in a query without any clauses or conditions.
4. The user can use the clauses, joins. and sub-query facilities to select the
rows from two or more tables. The datatypes for different databases are

automatically converted during data migration between them.

Lh

The query is finally formed is executed and the output is displayed in the

grid. The system asks for the destination table, database and other details,
Inputs
The following are the inputs of this function: -
v" Provider, Login Id, Password.
¥" Table Information, Destination databases.
Oulputs
The Tables are exported to the databases as per the user requirements.

Process Validations

v" Login validations

v Illegal colurnn functions checking.
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File

Functional Requirements

This function is used to collect Table information, Login information and etc.

This is used for migrating data between the databases.

Description

The function is described as a step by step procedure given below: -

1.

o)

The user selects the type of option for data migration. The following options
are: -

e) Oracle to File

f) File to Oracle

g) SQL Server to File

h) File to SQL

- Depending upon the option selected the Login information is collected from

the user. The tables are displayed in a tree structure. If the option is File to

Database then the user is allowed to locate the file.

- In Database to File option the tables are displayed in a tree structure. The

user selects the table, columns for migration. If the option is File to

Database, the system displays the content of the file in the form of a grid.

. Not all the files can be exported to the database. The structure of the file is

defined as the first line containing the table name, the second containing the
number of columns in the table and the third one containing the column
names separated by pipeline symbol. Each line has a delimiter as pipeline

symbol.
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5. Database to File option allows the user to specify the file name, path
and for the second option the Destination table name is specified by the
user. Finally the table is imported or exported depending upon the user’s

option.
Inputs
The following are the inputs of this function: -
¥" Provider, Login Id, Password.
v" Table Information, Destination databases, File name, and path.
Outputs

The Tables are exported from the databases or imported to the database as per

the user requirements.
Process Validations
v" Login validations

v Illegal column functions checking

v" Destination tables checking

Spreadsheet

Functional Requirements

This function is used to collect Table information. Login information and etc.

This is used for migrating data between the databases.
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Description

The function is described as a step by step procedure given below: -

1.

2

Inputs

The user selects the type of option for data migration. The following options
are: -

a) Oracle to Excel

b) Excelto Oracle

¢) SQL Server to Excel

d) Excelto SQL

. Depending upon the option selected the Login information is collected trom

the user. The tables are displayed in a tree structure. If the option is Excel to

Database then the user is allowed to locate the Excel file.

. In Database to Excel option the tables are displayed in a tree structure. The

user selects the table, columns for migration. If the option is Excel to
Database, the system displays the content of the Excel file in the formofa

grid.

. Database to Exce! option allows the user to specify the file name, path and

for the second option the Destination table name is specified by the user.

Finally the table is imported or exported depending upon the user’s option.

The following are the inputs of this function: -

v Provider, Login Id, Password.

v Table Information, Destination databases, Excel file name, and path.



Adhoc Query a

Quiputs

The Tables are exported to Excel Files or imported to the database as per the

user requirements,

Process Validations

¥" Login validations
v llegal column functions checking

v Destination tables checking

Module IDC——— >  3.2.5.2. Help Desk

Module Functions

Functions List

The following are the functions provided by this module

» Query Help
» DTS Help

Query Help

Functional Requirements

This function is used to collect Help Information. This is used to guide the
user for using ADHOC-Query.

L)
[¥5)
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Description
The function is described as a step by step procedure given below: -

1. The Help menu is displaved when the user presses F1 or by selecting
Query Help from the Help Desk.

[

The Help pages are designed using HTML., which can be navigated with

proper links provided within the pages.

3. The user can select the area for which guidance is needed. The pages are
displayed in the Browser form.

4. Each page helps the user to use the product efficiently and Query Help
normally contains information regarding how to build a query in Query
Wizard or how to write a SQL statement.

5. The address bar allows the user to connect to HTML pages on the Internet

for help other than in ADHOC Query.

Inputs

The following are the inputs of this function: -

v URL, Keywords.

Outputs

The Help pages are displayed as per the user requirements.
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Query Help

Functional Requirements

This function is used to collect Help Information. This is used to guide the
user for using ADHOC-Query.

Description

The function is described as a step by step procedure given below: -

[

Inputs

The Help menu is displayed when the user presses F1 or by selecting
Query Help from the Help Desk.

The Help pages are designed using HTML, which can be navigated with
proper links provided within the pages.

The user can select the area for which guidance is needed. The pages are
displayed in the Browser form.

Each page helps the user to use the product efficiently and Query Help
normally contains information regarding how to build a query in Query
Wizard or how to write a SQL statement.

The address bar allows the user to connect to HTML pages on the Internet
for help other than in ADHOC Query.

The following are the inputs of this function: -

v URL, Keywords.

Outputs

The Help pages are displayed as per the user requirements.

[
Th
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DTS Help

Functional Requirements

This function is used to collect Help Information. This is used to guide the

user for using ADHOC-Query.

Description

The function is described as a step by step procedure given below: -

o>

Inputs

The Help menu is displayed when the user presses Fl or by selecting
Query Help from the Help Desk.

The Help pages are designed using HTML, which can be navigated with
proper links provided within the pages.

The user can select the area for which guidance is needed. The pages are
displayed in the Browser form.

Each page helps the user to use the product efficiently and DTS Help
normally contains information regarding how to migrate tables. taking
backups & recovery, providing privileges etc.

The address bar allows the user to connect to HTML pages on the Internet

for help other than in ADHOC Query.

The following are the inputs of this function: -
v URL, Keywords.

Outputs

The Help pages are displayed as per the user requirements.

26
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4.0 Data Flow Diagram

4.1 DTS

4.1.1 Database to Database:

User

N
Provider, Login Details. Oracle/SQL Database

Type of operation / /
Valid Login Id /
/

& Password

/ Tables
. . Migraled Tabies
Validation

| Destination Table

User name, Database Data
Migrator

Name, Id, Password
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4.1.2 Database to File:

User
~
Provider, Login Details,
Type of operation

Invalid
Togin

N\

Validation

User

name, and path

| 'l'able name, Vile

Oracle/SQL Database
Valid Login Id /
& Password /
/ Tabics

Table names

{ File
\ Converter

e

File

System
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4.1.3 File to Database:

User

N
Provider, Login Details, Oracle/SQL Database

‘Type of operation /'

Valid Login Id
& Password

/ Tahle

Validation /

Table name, N
User Column Definition Table
Converter
File name, /
Path File
File path,
name

Query
Retriever

System
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4.1.4 Spreadsheet to Database:

User
N
Provider, Login Details, Oracle/SQL Database
Type of operation /' A
‘f
Invalid Valid Login 1d
[.ogin & Password
Validation
Table name, Sheet
I gl
User name, Column Table \
j Definition Converter |
Excel Sheet name, /
Path File
File path,
name
Excel g

Retriever System

File
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4.1.5 Database to Spreadsheet:
User
~
Provider, Login Details, Oracle/SQL Database
Type of operation

Invalid Valid Login Id /
[.ogin & Password /

Tabies
Table names

/

Validation

User

Table name, Excel )
Book name, Sheet Excel
namic and path

Converter

File

System

|93}
2
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5.0. Sample Forms

5.1. Data Transformation Services:

Aad-Hoo

34
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<Ad-Hoo Whzard

Specify table copy or query

Speiify whethr ko coy onis or more tables o results of the giery From the

AR,

|pat
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d-Hoo Wizard
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5.2. Help Desk System:

43
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6.0 System Testing And Implementation

6.1. Testing

Testing is an important phase in development in software development

and application development in the world wide web. Testing will lead the error

free application to the client.For this Automating Resources Time Scheduling

there is a need of six types of testing.

6.1.1.

6.1.2.

v' They are

Unit Testing
Validation Testing
Integration Testing
Output Testing

Acceptance Testing

AN NN

User Acceptance Testing

Unit Testing:

Unit testing comprises the set of tests performed by an individual
programmer prior to the integration of the unit into the large system. A
program unit is usually small enough that the programmer who developed the
unit can test it. Then the unit is integrated into the large part of the system.
Unit testing is always white-box oriented and the step can be conducted in

parallel for modules.

Validation Testing:

Software testing and validation is achieved through .a series of
black box tests that demonstrate conformity with the requirement. A test plan
outlines the classes to test to be conducted and a test procedure defines
specific test cases that will be used to demonstrate conformity with the
requirements. Both, the planned the procedures are designed to ensure that ali
functional requirements are achieved, documentation is correct and other

requirements are met. After each validation test case has been conducted.
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6.1.3

6.1.4.

6.1.5.

one of the two possible conditions exists. They are the function or performance
characteristics conform to the specification and are accepted.

A deviation from specification is uncovered and a deficiency list is
created. This project is validated under different test conditions. The

requirements as per the specification are met.

Integration Testing:

Bottom-up integration is the traditional strategy to integrate the
components of the software system into the functional unit. Bottom-up
integration consists of unit testing of the entire system.

Modules are tested in isolation from one another in an artificial
environment, known as a ''test haremess",which consist of the driver
programs and data necessary to exercise the modules.

Moreover Integration testing addresses the issues associated with the
dual problem of verification and program construction. After the appplication

has been integrated a set of high-order tests were conducted.

Output Testing:

The outputs are thoroughly tested by giving sample data, for
which results are known.The outputs from the system are matched with that of

the known values and the results are found to be accurate.

Acceptance Testing:

Acceptance testing involves planning and execution of
functional tests,performance tests, and stress tests in order to demonstrate that
the implemented system satisfies its requirtements.

In addition to the functional performance tests, stress tests are
performed to determine the limitations of the system. Tools of special
importance during acceptance testing include a test coversge analyzer, a
timing analyzer and a coding standard checker.Testing is the process of

executing test cases with the intension of exposing the errors.
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6.2 System Implementation:

Implementation is the stage where the thoeratical design is

converted into working system. It consist of
Testing and Debugging

v

v" Error Correction
v" Training the user
v

Change over

Implementation includes equipments installation and user
training. For the system to begin operation, a sufficient number of users have
been trained to the system. Several hours were sheduled for a number of users
so that they were able to fully understand the new system and had an
opportunity to familarize themselves with the various input screens and the
generation of output.

The change over is another important aspec: of the
implementation process and had to be handled carefully. The existing system is
changed to the new system and the system is found to meet its objectives. Data
from the previous system, static contend. is ported to the new system and the
result produced are compared with that of the previous system. The new
system is found to satisfy the user needs.

It allows the result to the new system to be compared with the
old system before acceptance by the user, there by promoting the user

confidence.
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Conclusion

The project ADHOC Query was successfully designed and developed
for the client for their Database activities.

The application is very user-friendly and after successful testing and
implementation the feed back was taken from the client users that it works
efficiently and the application was fruitful.

The application does not include operations on PL/SQL and will be
included after the client request.

Thus I conclude that this project has been developed successfully

satisfying the requirements put forth.
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